Hardware Setup and Software Installation
# Table of Contents

**Getting Started** .......................................................... 1  
Unpacking instructions: .................................................... 1  
Box Contents: ................................................................. 2  
**A Brief Tour** ............................................................... 1  
Main Assembly ............................................................... 3  
Rear Compartment ......................................................... 4  
Side Panel ......................................................................... 5  
Control Panel ..................................................................... 6  
Laser Head ........................................................................ 7  
**Safety Information** .................................................... 8  
Laser Safety ....................................................................... 8  
Electrical Safety ............................................................... 9  
Fire Safety ......................................................................... 9  
Additional Safety Measures ............................................. 9  
**Hardware Setup and Basic Laser Operation** ................. 14  
Typical Workbench Setup .................................................. 14  
Testing your Laser ........................................................... 15  
Focusing Your Laser ........................................................ 15  
Software Options ............................................................. 18  
Aligning Your Laser ........................................................ 18  
Adjusting the Z-Plate ......................................................... 22  
**RetinaEngrave USB Software Installation** ...................... 23  
For Windows Vista / Windows 7 (32-bit and 64-bit) ............. 23  
For Windows XP 32-bit ...................................................... 26  
**RetinaEngrave USB Software Operation** ....................... 30  
Vector Vs Raster ............................................................... 30  
Using RetinaEngrave USB ............................................... 31  
Converting Curves to Hairlines: CorelDraw X5 .................. 33  
Joining Curves: CorelDraw X5 ......................................... 35  
Designating Colors to Layers for RetinaEngrave USB .......... 35  
Combined Raster Engrave and Vector Cut ......................... 39  
**Appendix A: Troubleshooting** ................................... 43  
**Appendix B: Specifications** ........................................ 46  
**Appendix C: Warranty Statement** ................................. 47
Getting Started

Thank you for your recent purchase of your 4th generation Full Spectrum Laser LLC Hobby Laser. It is our wish that this product adds value to your business or hobby activities for years to come. Please take time to read this manual in its entirety to safely use your laser to its full potential.

Important:
Please carefully read all the instructions before attempting to operate the laser. Never operate or test the laser without the water pump running and water. Never attempt to operate the laser with the lid open or attempt to override the magnetic lid protection switch.

These installation instructions available online www.fullspectrumengineering.com/lasersetup. Familiarize yourself with the major components of your new hobby laser before use.

Unpacking instructions:

1. Open the box and remove the documentation located between the packing material and box flaps as well as the honeycomb table.

2. Place the box onto a soft surface such as a mattress or foam pad (not included) and turn the box upside down. Lift the box, letting the weight of the unit pull it down as the box is lifted off. Opening the box in this manner will prevent any damage to the Styrofoam packaging material. Do not attempt to directly lift the laser out of the packaging by grabbing the Styrofoam packaging as it will break.

3. Remove bottom packing pieces and turn unit over so that standoffs are touching the floor and unit is in an upright position.
4. Remove remaining packing material and inspect the unit for any damage during shipping. Open the back lid and inspect laser tube assembly carefully. Open the front lid and remove accessories within. Please inspect the laser tube carefully for any shipping damage and contact us immediately if there are any visible cracks.

5. Often we will ship the laser with a hose clamp on the right round rail which

Box Contents:

1. 40w Hobby Laser w/ Power Cord
2. Black Water Pump
3. White Exhaust Fan and blue 4" diameter hose
4. Silver Honeycomb Cutting Table
5. Air compressor (Optional but highly recommended. Shipped separately from main unit)
6. RetinaEngrave USB card and mini USB cable (optional upgrade, may be shipped separately)
7. Brown cutting depth adjustment ruler
8. Set of keys that operates on/off switch, opens control panel compartment and rear laser tube compartment.
GETTING TO KNOW YOUR LASER

A BRIEF TOUR

Main Assembly

1) Lid with Safety Glass
2) Control Panel
3) Stationary Mirror
4) Y Axis Mirror
5) Laser Head
6) Secondary Laser Pointer for optional beam combiner
7) Beam Combiner (Optional)
8) X folding cable carrier
9) Y folding cable carrier
10) Feet Standoffs
11) Z table adjustment screw (adjusts the height of the table from the bottom)
12) Lid Magnet (silver)
13) Magnetic Safety Interlock Switch (black)
GETTING TO KNOW YOUR LASER

Rear Compartment

1. Laser tube  
2. Laser Exhaust Fan mount holder  
3. 110v Outlet for water pump (not recommended for use, plug pump directly to wall power)  
4. 110v Outlet for air compressor (turns on/off with air compressor switch on control panel)  
5. 110v Outlet for fan (not recommended for use, plug the fan directly to wall power)  
6. Water inlet hose  
7. Water outlet hose  
8. Stationary mirror  
9. Red high voltage laser power cable  
10. Black high voltage laser power cable  
11. Hose from Air compressor (push blue nub inward to allow insertion of tube)

**Important:** The current meter is used to tell how much power is going to the laser. Keep the current **under** 15mA for maximum laser tube life.

Avoid running the laser above 15mA for extended periods of time. Use more passes instead of more power for thick materials. Running above 20mA will drastically shorten the expected laser tube life.
Side Panel

1. Power supply
2. Exhaust Fan
3. RetinaEngrave USB access point
4. 110V 3 prong power plug with 6A fuse (maximum 660W)
5. Ground point (attach to earth ground)
1. E-stop button (depress to disable)
2. Power meter (0-30mA)
3. Current Regulator knob (10 turns)
4. Laser test buttons 
   (press both simultaneously to activate)
5. CO2 Laser enable/disable switch
6. Switch for interior light
7. Air compressor switch 
   (turns off power to air compressor if plugged into back)
8. Key switch
GETTING TO KNOW YOUR LASER

Laser Head

1. Invisible CO2 laser beam entrance hole
2. Side shooting Class 3a red laser pointer - always on. Focus invisible CO2 laser first with the ruler then fire a dot on a piece of paper and align the red laser dot so it hits the same spot. The optional beam combiner provides better performance since it goes through the lens.
3. Knurled aluminum lens holder (remove air assist nozzle first before removing lens).
4. Screw which holds the air assist nozzle
5. Screw which holds final mirror
6. Flexible air assist hose into self folding cable carrier on X axis gantry
SAFETY INFORMATION

Please carefully read all the instructions before attempting to operate the laser. Never operate or test the laser without the water pump. Never attempt to operate the laser with the lid open or attempt to override the magnetic lid protection switch. Please inspect the laser tube carefully for any shipping damage and contact us immediately if there are any visible cracks.

Laser Safety

Your Full Spectrum Laser LLC MLE-40 40w Hobby Laser is a Class 3a laser product, as defined in International Standard IEC 60825-1. The laser complies with 21 CFR 1040.10 and 1040.11, the Federal Performance Standards for Light-Emitting Products, except for deviations pursuant to Laser Notice No. 50, dated July 16, 2001. The Center for Devices and Radiological Health, of the US FDA, issued Laser Notice No. 50 to permit manufacturers to classify and manufacture their products in accordance with the International Standard.

The output of the CO2 engraving laser is fully contained in a Class 1 enclosure except for the visible red laser pointer which is rated as a Class 3a laser product.

The laser cabinet has a magnetic safety interlock switch that deactivates the laser off if the door is opened during operation, and no special precautions are necessary to operate the high power laser safely. Never attempt to defeat the magnetic safety switch.

The operator of the 40w Hobby Laser should observe the following general precautions:

- DO NOT disassemble the machine or remove any of its protective covers while the unit is plugged in.
- DO NOT attempt to defeat the door interlock.
- DO NOT view directly into the beam of the Red Laser Diode Pointer.

Caution – Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous laser radiation exposure.

Important: The current meter is used to tell how much power is going to the laser. Keep the current under 15mA for maximum laser tube life.

Avoid running the laser above 15mA for extended periods of time. Use more passes instead of more power for thick materials. Running above 20mA will drastically shorten the expected laser tube life.
G E T T I N G  T O  K N O W  Y O U R  L A S E R

Electrical Safety
The AC input power to the 40w Hobby Laser is potentially lethal and is fully contained within the cabinet.

- DO NOT open any of the machine’s access panels while the unit is plugged in. Opening a panel may expose the operator to the unit’s AC input power.
- DO NOT make or break any electrical connections to the system while the unit is turned on.

Fire Safety
Laser cutting and engraving systems represent a significant fire hazard. Most engraving materials are inherently combustible. While, the objective of most cutting and engraving operations is to vaporize material without burning, it is easy to ignite a flame. Experience shows that vector cutting with the laser has the most potential to create an open flame. Acrylic, in all its different forms, has been shown to be especially flammable when vector cutting with the laser.

Please read the following warnings and recommendations and follow them closely at all times!

- NEVER let the laser system operate if it will be unattended.
- ALWAYS keep the area around the machine clean and free of unnecessary clutter, combustible materials, explosives, or volatile solvents such as acetone, alcohol, or gasoline.
- ALWAYS keep a properly maintained and inspected fire extinguisher on hand.
- KEEP YOUR LASER SYSTEM CLEAN—Regularly remove the honeycomb grill to clean any small pieces that have fallen through the grid.

Additional Safety Measures
NEVER operate the machine without a properly operating vent to the outside!

NEVER engrave or cut any material containing chlorine or hydrogen gas such as PVC or vinyl. Doing so will produce gasses that will corrode the interior of the laser and is not covered under warranty.

NEVER operate your machine unattended. There is a significant risk of fire if the machine is set improperly, or if the machine should experience a mechanical or electrical failure while operating.

NEVER vector cut any material while the machine is unattended. Because vector cutting moves relatively slowly compared to raster engraving, a tremendous amount of heat is applied to the material being cut. This build up of heat can cause significant fire risk and the machine should always be monitored.

NEVER operate with any of the covers or enclosures removed, and never modify the enclosure. The laser beam is invisible!
HARDWARE SETUP AND BASIC LASER OPERATION

Although power outlets are supplied on the back of the Hobby Laser for the Exhaust Fan, water pump and air compressor, we recommend connecting these devices to a power strip or circuit breaker separate from the laser (unless the breaker is 110v 20 amps or higher). Always ensure these devices are powered on before starting the Hobby Laser.

Water Pump

**Important:** Do not run the laser without water cooling! The water pump is 110V and needs to be plugged into a power bar. Do not plug in the water pump into the back of the laser.

The laser has a 1/4" OD plastic water tubing for inlet/outlet. The tubing comes recessed inside the unit. Simply pull out of the corresponding holes and connect to the water pump. A 5 gallon bucket filled with distilled water or other receptacle must be utilized to hold the water and contain the pump.
Exhaust Fan

**Important:** Do not cut materials without proper ventilation! The fan also extracts smoke to keep the laser cabinet clean. Do not cut anything without the fan. It is not recommended to plug the fan into the unit, as the fan can be disabled with the button on the control panel. This can result in the unit being operated without exhaust capabilities.

Install the 4" Exhaust Fan port on the back of the laser. Slide it downward so that it is secured between the three holding braces. The exhaust hose is 4" diameter. One end is flanged and should exhaust debris away from the unit. Ensure that it leads to an open space, away from and outside the engraving area. Fit the end of the hose that is not flanged on to the Exhaust Fan port. A zip tie can be used but is not necessary.
GETTING TO KNOW YOUR LASER

Air Compressor (optional upgrade)

Important: Do not cut anything on the laser without the air compressor running. Constant air flow keeps smoke from depositing soot onto the laser lens.

Install the optional air compressor by connecting the air compressor tubing. The blue air hose connector on the back of the laser accepts a hard plastic tubing with 0.23" outer diameter (OD) tubing and 0.17" inner diameter (ID) by means of a friction lock. Simply push the tubing into the blue connector and it will lock into place. This tubing is included with our air compressor. The Full Spectrum Laser air compressor puts out around 2200L/min of air.
Honeycomb Cutting Table

The cutting table must be installed in the laser bay prior to use of the system. It serves to disperse any reflected laser energy as well as position the engraving material within the proper distance from the laser head. Turn the Z-axis adjustment screw underneath the unit to raise or lower the platform.
Typical Workbench Setup

1) Laser on stainless steel work table
2) Computer on stand
3) 5 gallon bucket of distilled water with water pump fully submerged
4) Extended 4" air exhaust hose to outside dryer vent (not included)
5) Fire Extinguisher
6) Air compressor on ground (not shown)
7) Power strip with laptop/laser/water pump/air compressor plugged in (not shown)
Testing your Laser

**Important:** The laser current can be adjusted within RetinaEngrave as well as with the Current Regulator Knob on the laser. For fine control of current, the current regulator knob has a range of 10 complete turns between zero and maximum values. Once the job has started, power cannot be adjusted within RetinaEngrave. Use the Current Regulator Knob to adjust power while a job is underway.

**Important:** The current meter is used to tell how much power is going to the laser. Keep the current under 15mA under normal use to maximize the life of the tube. Avoid running the laser above 15mA for extended periods of time. Use more passes instead of more power for thick materials. Running above 20mA will shorten the expected laser tube life.

1) Close the lid.
2) Make sure the laser enable/disable push switch (small red button) is pressed down. Make sure the E-stop button is **not** pressed down (large red button).
3) Press both green laser test buttons adjacent to the laser enable/disable switch (small red button) to fire a pulse.

Adjust the current with the knob. The current meter shows you how much power the laser tube is getting. The more you turn the knob clockwise the more power the laser will generate. The laser will not operate with the lid open because it has a magnetic deactivation switch.

Focusing Your Laser

**Important:** The laser must always be in focus when in operation. Not only will you not have full power but low power out of focus laser beams will tend to burn or start fires instead of cutting through materials.

The laser lens works like a magnifying glass and produces a sharp cone of light. Focusing the laser is done with the included focus ruler. The focal length of the lens included with the laser is 2 inches (55mm) but the plastic ruler measures 2.77". Slide the gauge between the aluminum laser plate and the work surface as shown in the picture below.
Top of ruler contacts bottom of laser head plate (not attached to red pointer)
Rotate by hand to raise/lower Z-Table
Optional acrylic wheel can be attached here.

Optionally, the focus can also be set with a digital depth gauge as shown below. Here we measure 2.89" from the top of the aluminum laser head plate to the work surface. Add 0.89" to any longer focus length lenses you may use.
Aligning Your Laser

Often times when the laser does not produce an even burn over the entire workspace, the laser is out of alignment. Usually this is characterized by uneven burning with the left side of the image darker than the right side (see image below). If the laser is extremely far out of alignment, no spot through the lens may appear at all. One can always verify the laser is working by placing a small piece of paper near the stationary mirror and pressing both green laser test switches. If the current meter is moving, the laser is working.

Your laser is carefully aligned at the factory but may come out of alignment during shipping or unpacking. This procedure will explain to you how to align the laser for optimal cutting.

The laser path is shown below. The invisible beam bounces off the stationary mirror (not shown) behind the optional beam combiner (normally not included). Then the beam passes through the beam combiner (1) and bounces off the moving Y axis mirror (2). The beam proceeds to bounce off the flying X axis mirror (3) down the laser tube and through the lens (4). If any of the mirrors is off by even 0.1 degrees, the results will not be good.
We recommend the following procedures and tests:

1. Usually only the Y axis mirror (2) needs to be adjusted. Your laser was carefully tested at the factory. It is very unlikely you will need more than a few turns of the screws.

2. Obtain some thermal receipt paper (almost all credit card printers use thermal receipt paper - used paper is ok) and tape it to the laser head (3) over the entrance hole.

3. When aligning the laser, do not worry about hitting the center of the mirrors. The invisible CO2 beam diameter is around 5mm and the mirrors are 20mm in diameter so all the collected energy will be reflected even if off center. You should only be concerned about where the laser beam hits the thermal paper when taped over the laser head.

4. Move the laser head closest to the Y axis mirror (2) as shown below. Moving the laser head close to the Y axis mirror (2) provides the least distance for the laser to travel. Any alignment errors are magnified when the laser head is far away from the Y axis mirror.
5. Adjust the current knob all the way counter-clockwise to set the power to zero. Now press **both** green laser test switch buttons. Gradually turn the current knob clockwise and press the test buttons again until a dark spot appears on the thermal paper but the power is not enough to burn a hole through the thermal paper. You want to avoid burning holes through the thermal paper because this will leave smoke residue on the mirrors. Thermal paper darkens at a much lower threshold than it takes to burn a hole in it.

6. Adjust the screws on the Y axis mirror in **small** increments. A quarter turn will put the laser out of alignment. Tighten screws 1 and 2 to tilt the laser beam up. Tighten 2 to shift it right. Tighten 3 to shift it down. Tighten 1 to shift it left.
7. Adjust the screws so that the dark spot produced on the thermal paper is exactly in the center of the hole of the laser head.

8. Move the laser head to the right about 2 inches. Now press the laser test buttons again and see where the spot is. The further to the right you move the laser head the more amplified any angle alignment errors in the laser beam will be. Adjust it until the dark spot produced is centered on the laser head even with the laser head all the way to the right.

9. It is not necessary to have exact dead center spots for all locations. As long as the laser beam goes down the hole, it will reflect off the mirror and the focusing lens will correct any small errors. However, the better aligned you have the laser, the better your results will be for detailed work.

10. Aligning the laser should only need to be done once unless you bump the lens or the mirror.
Adjusting the Z-Plate

The Z-axis is raised or lowered with a belt that connects 4 screws. Under some circumstances the belt can slip on one of the screws and cause the Z axis table to become uneven. If the Z-axis is not flat, remove the sets of screws holding down the Z-table. A belt connects all the screws which raises or lowers the Z table. Adjust each of the screws until they are level by holding the belt and twisting the screws independently. The easiest way to do this is to remove the belt and drop all the screws as low as they can go then reattach the belt.
Adjusting the Belt Tension: X-Axis

In some cases, the belt tension might need adjustment on initial receipt. Movement should be smooth and not grainy or overly difficult. If the laser engraves at lower speed but at 100% speed the laser seems to jerk or stall, the belt tension should be loosened. If engraving lines do not appear straight, the belt tension should probably be increased. Adjust the bolts shown in the picture with a 3mm hex key. Purchase a long hex key and there is an access hole on the right hand side of the machine. Turning clockwise increases the belt tension.

If the belt tension has been adjusted correctly and the movement of the laser head still moves with grainy or overly difficult motion then you may also need to adjust the wheels attached to the laser head. Turning the screw clockwise will tighten the wheel.
Software Options
Your laser has 2 control options: Mach3/EMC2 control card/motor driver via a parallel cable (Basic Laser) and RetinaEngrave USB (requires optional RetinaEngrave USB Controller, included in Deluxe Laser).

Mach3/EMC2

- Connect the laser to the parallel port with a DB25 Male to Female cable (not included) no longer than 6 ft.
- If connecting through the parallel port, download applicable drivers and the Mach3 application from: www.machsupport.com. A free demo version is available, limited to 500 lines of G-Code or less.
- For Linux systems, EMC2 is available free of charge from www.linuxcnc.org
- Mach3/EMC2 software is not produced or sold by Full Spectrum Laser LLC and software support must be handled directly by directly contacting the respective software authors listed above. Mach3/EMC2 are not trivial programs to use and Full Spectrum Laser LLC recommends our own software package and control system RetinaEngrave USB.

RetinaEngrave USB

RetinaEngrave USB is the easiest to use, most accurate and most powerful laser control program, 100% written by Full Spectrum Laser LLC. As RetinaEngrave USB is written by Full Spectrum Laser LLC, we provide support using this software package through our support forums at http://www.fullspectrumengineering.com/forums

The RetinaEngrave USB system currently requires a three part download on a Windows based computer:

- RetinaEngrave USB Drivers
- RetinaEngrave application software
- True Direct Print Driver
For Windows Vista and Windows 7 (32-bit and 64-bit)

**Step 1)** Save the USB driver "CDMxxxxx_setup.exe" file to your desktop then double click it. **In some cases you may need to double click it twice.** You will receive a black console window saying the drivers were installed properly (see picture below). If you do not see this console window, you need to double click the file again. **Double check that you have received confirmation that the driver was installed! If it says nothing then it didn't install and you need to click it again.**

Current download link: [http://fullspectrumengineering.com/files/CDM20802_Setup.exe](http://fullspectrumengineering.com/files/CDM20802_Setup.exe)

![Console window showing driver installation](image)

**Step 2)** Save the RetinaEngrave setup file "RetinaEngraveVxxxx.zip" to your desktop. Double click the .zip file to display the contents, and then double click "setup." This installation program will install the Microsoft .Net framework 4.0 if required. You may be required to restart your computer to finish the install.


Note: this software is updated frequently. Please check the software download page for recent versions: [http://fullspectrumengineering.com/Protected/DownloadRetina.html](http://fullspectrumengineering.com/Protected/DownloadRetina.html)
GETTING TO KNOW YOUR LASER

RetinaEngrave USB Installation

Welcome to the RetinaEngrave Setup Wizard

The installer will guide you through the steps required to install RetinaEngrave on your computer.

WARNING: This computer program is protected by copyright law and international treaties. Unauthorized duplication or distribution of this program or any portion of it may result in severe civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Press Next to initiate the installation.

Select Installation Folder

The installer will install RetinaEngrave to the following folder:

To install in this folder, click "Next". To install to a different folder, enter it below or click "Browse".

Folder:

\Program Files (x86)\Full Spectrum Laser LLC\RetinaEngrave,

Install RetinaEngrave for yourself or for anyone who uses this computer:

- Everyone
- Just me

In most cases, the default directory is sufficient. Your install directory may differ if RetinaEngrave is installed on a 32bit Windows system.
GETTING TO KNOW YOUR LASER

Press Next to start installation

Installation is complete
Step 3) Save the Direct Print Driver setup file "FSELaserDriversWin7Installer.zip" to your desktop. Double click the .zip file to display the contents, and then double click "setup." This will silently install the printer driver, after which the "Full Spectrum Engineering Driver" will appear under your printing devices list. This is now registered as a printing device and is accessible from any application that can print.

Current Download Link (Vista/Win7 Users):
http://fullspectrumengineering.com/Protected/FSELaserDriversWin7Installer.zip

For Windows XP 32-bit

For best performance, Full Spectrum Laser LLC strongly recommends a computer that runs Windows 7. Windows XP has been tested and works without issues but requires additional steps and is intended for advanced users only. Windows XP was released over ten years ago and Microsoft no longer sells Windows XP on new computers. Microsoft has released several patches to the Windows XP operating system that must be installed to support the advanced features of RetinaEngrave USB. Please consult the RetinaEngrave USB software download page for Windows XP installation instructions.

Current Download Link (Windows XP Users):
http://fullspectrumengineering.com/Protected/fselaserXP.zip
Important:
Before using your Hobby Laser, ensure that the Exhaust Fan, air compressor and water pump are operational.

Vector Vs Raster

RetinaEngrave USB supports both Vector and Raster modes. In addition, RetinaEngrave supports drawings with combined Vector and Raster information.

Vector drawings are represented by the computer as mathematical descriptions. Examples of vector data are arcs, lines, polylines, and curves. Programs like AutoCAD (.dxf, .dwg), Adobe Illustrator (.ai), CorelDraw (.cdr), Inkscape (.svg), and Draftsight (.dxf, .dwg) can produce vector output. In vector mode, the laser traces the path of the drawing which allows for cutting. Vector data has the advantage that it can be scaled to any resolution without loss of definition. Pen plotters also work in vector mode.

Raster data consists of pixels. Examples of raster programs include Adobe Photoshop and MS Paint (.bmp, .tif, .jpg, .png, etc). In Raster mode, the laser will scan left to right and fire when the image is black and not fire when it is white. Raster data can only be used for engraving. Inkjet printers work in raster mode.
Using RetinaEngrave USB

**Step 1)** Open up RetinaEngrave USB by double-clicking the icon. Leave this running in the background or minimized. If you close the program, the direct print function will not work because the program cannot capture the print stream from Windows if it is closed. However, you can print to an XPS print file while RetinaEngrave is not running and open this XPS file at a later time to print.

**Step 2)** Print from any application and select the Full Spectrum Engineering Driver as the printer. Vector mode will only capture Vector output. Vector mode has been tested with many different vector programs such as CorelDraw X5, AutoCad 2011, Inkscape, Adobe Illustrator, Draftsight and more as shown in our demo videos. However, if you have problems vector printing to RetinaEngrave, use CorelDraw X5. Read the tips on CorelDraw on our forums how to import most file types such as DXF files into CorelDraw. Raster mode should print from any program.

**Step 3)** Vector Mode: RetinaEngrave can also open .PLT files from CorelDraw and .XPS in vector files. PLT generation from other programs besides CorelDraw has not been tested.

**Step 4)** Raster Mode: RetinaEngrave can also open .XPS files and most image formats (GIF, BMP, JPG, TIF, etc). However, RetinaEngrave handles 1-bit bitmaps differently from other formats as it does not rescale a 1-bit bitmap. In 1-bit mode, 1 pixel = 1/1000 of an inch or 1/500 or 1/250
depending on the selected output resolution. If the pixel is black it will fire the laser; otherwise, it does not fire. 1-bit bitmaps produce the most predictable output. Other image formats are best effort conversion and up-scaling. You can generate your own 1-bit dithered images for grayscale effects. There is a tutorial using Adobe Photoshop to generate 1-bit bitmaps on www.fullspectrumengineering.com/forums.

**Step 5)** Adjust the threshold setting to include or exclude portions of the drawing if in Raster mode. Adjust the power and ordering with various color settings if in Vector mode. Visit http://www.fullspectrumengineering.com/forums for more advanced options and tips.

**Step 6)** If in Raster mode, select the DPI. 1000x1000 dpi means there are 1000 left to right sweeps per vertical inch. 250x250dpi means the laser only sweeps 250 times per vertical inch. Higher DPI will also engrave deeper because the average laser on time per unit area is higher. Engraving at 250dpi will be 4x faster than 1000dpi.

**Step 7)** Press the "Go" button to start the cutting. The cutting happens in the background and while every effort is made to efficiently multi-thread the process, avoid doing intensive computer tasks while cutting because the trajectories are calculated on the fly by the computer. Also monitor the progress of the cut on the lower right hand corner. RetinaEngrave USB has a large buffer so may continue engraving even after the computer has reached 100%.

**Step 8)** You can look at the "config.xml" file in the install directory in a text editor for more configuration options (advanced users only).

**Step 9)** Go into "Control Panel\Hardware and Sound\Power Options\Edit Plan Settings\Change advanced power Settings" and make sure "USB settings\USB selective suspend setting" is **disabled**.
CONVERTING CURVES TO HAIRLINES: CORELDRAW X5

In vector mode, lines should be reduced to the minimum thickness allowable by the drawing program. In CorelDraw X5, these are known as *hairlines*. If lines are not reduced to hairlines, RetinaEngrave USB may trace the boundary of the line instead following the center of the line during vector cutting.

1. **Left Click:** Edit -> Select All -> Objects. This will select all objects.
2. Left Click: Outline Pen Tool -> Hairline Outline. This will change the width of all lines to Hairline.

In this example object our line width is 0.5 pt

After applying Hairline Outline our line width is now Hairline (thinnest possible)
Joining Curves: CorelDraw X5

For predictable output, vector drawing should be closed as much as possible. Many times vector drawings (in particular DXF files) may have small breaks that will confuse the RetinaEngrave USB print driver.

CorelDraw X5 has a great command: Arrange -> Join Curves. This will join touching lines into a closed path suitable for laser cutting. In this example our object is 1” width by 0.282” height.

At 500% zoom the object appears to have all lines connected.

However at 6400% zoom on the bottom left corner of the same object we can see that some of the lines are merely touching and are not connected.
1. Select all objects you want to correct. Left Click on Arrange/Join Curves.

2. The Join Curves window will appear on the right side of your screen. Click Apply.

Note: The default settings of: Extend and Gap tolerance 0.1” should be sufficient for most users.
Here is the same object at 6400% zoom - all lines are now connected and we have a closed path.
Designating Colors to Layers for RetinaEngrave USB

Designating a color to objects/ layers you want to vector cut enables you to take advantage of RetinaEngrave USB’s ability to specify cutting order, cut speed, laser power, and number of repeats to each individual layer.

Currently, RetinaEngrave USB supports up to seven standard color layers for maximum program compatibility: Black, Blue, Red, Magenta, Green, Cyan, and Yellow from the RGB color palette.

RetinaEngrave uses a best guess color round off routine when a color is not a standard RGB color. Avoid Black whenever possible because this is the default color RetinaEngrave uses whenever it cannot figure out what color it should be. By avoiding Black, you will have more control.

Always assign the outline stroke (the object border) the desired color and not the fill of the object. Always use an empty fill when possible.

1. Open your .cdr vector format file in CorelDraw X5.
2. Make sure you have the Object Manager window open by Left Clicking: Tools, Object Manager
3. **Right click** on the object in the Object manager that you want to designate a color to.
4. **Left click** on “Properties” in the pop-up window

In this example image we have seven objects on seven different layers.

5. In the Object Properties window **Left Click** on the Outline Pen tab.
6. In the Outline Pen properties window **Left Click** on the down arrow next to “Color:” to change the outline color of the currently selected objects to one of the seven supported colors.
In our example image we have changed the outline color of one object to blue. It is possible to have more than one object the same color. In our example image all objects that have a black outline would be considered to be on the **Black** layer in RetinaEngrave USB and the single object with the blue outline would be considered to be on the **Blue** layer in RetinaEngrave USB.

7. Repeat steps 3 through 6 as necessary to change the outline color of objects, specifying one of the supported colors to each layer of objects up to a maximum of seven.

   In our example image we have changed the outline color of seven objects, one on each layer.

8. When your image is finished be sure RetinaEngrave USB is running in the background and File/Print using our Direct Print Driver.

9. Switch the current program to RetinaEngrave USB and **Left Click** on the Vector Cut Tab.
10. In the layer settings window on the right you can now change each colored layers cut settings.

The Useful Repeats Function

The repeat function allows you to automatically do multiple passes.

Want to ignore a layer? You can set Repeats=0.
Combined Raster Engrave and Vector Cut

RetinaEngrave USB supports combined raster engraving and vector cutting in the same job. In this section, we describe the process of using CorelDraw X5 to properly prepare your image before direct printing to RetinaEngrave USB.

1. Using the methods from our tutorial on designating colors to layers, designate either yellow or cyan to the layers you want to vector cut and designate black to the layers you want to raster engrave.

In our example image we want to:
1) Engrave the text and the four corner objects in raster mode by changing them to black.
2) Cut the middle object and the outside border in vector mode by changing them to yellow or cyan.

Example image after designating black to raster objects and yellow/cyan to vector objects:

Note: In a combined raster/vector image you can designate yellow and cyan to different vector objects. This allows you to adjust cut settings (speed, power, etc) in RetinaEngrave USB’s Vector Cut mode for both the yellow layer and the cyan layer.

Example image after designating black to raster objects and yellow/cyan to vector objects:

Note: Make sure that any text that is “Artistic Text” in CorelDraw X5 has a Hairline outline applied.
2. Verify RetinaEngrave USB is running in the background.
3. File ➔ Print using our Direct Printing Driver.
4. Switch the current program view to RetinaEngrave USB.
5. Verify you are in RetinaEngrave USB’s Raster Engrave mode by using the pull down menu and selecting Raster Engrave Only.
6. Adjust the slider on the the threshold setting to fade out/in objects. RetinaEngrave will only raster what is visible on the screen. Adjusting the slider to the left will fade out objects, while sliding to the right will fade in objects. You can also adjust the threshold by manually typing a value into the box next to the threshold slider between 0.000 and 1 and then left clicking on the image. The maximum threshold value of 1 will make the image solid black and should not be used. For optimal results first adjust the threshold almost all the way to the right to a value of 0.999.

Note: In RetinaEngrave USB’s Raster Engrave mode all objects will show as black. The objects designated as yellow or cyan in CorelDraw X5 will fade out before the objects that were designated as black will fade out.
7. Slowly adjust the threshold setting to the left until the vector objects that you previously designated yellow and/or cyan in CorelDraw X5 completely fade out, leaving only the black raster objects visible. In our example image we found that a threshold setting of 0.96 made the center yellow vector object completely fade out. The cyan vector border has not faded out and further threshold adjustment is needed.

Further adjustment of the threshold to the left to a value of 0.9 makes the cyan vector border completely fade out. The threshold for our example image is now properly adjusted leaving only the black objects that we want to raster engrave visible. The end goal when adjusting threshold value is to adjust the threshold to the left just enough to make the yellow/cyan objects fade out while leaving the black raster objects highly visible for optimal detail raster engravings. Threshold settings for your particular image could vary from our example image settings.
8. Adjust the Speed % and DPI to your desired settings.
9. Left Click on the “Go” button to raster engrave your material.

Note: When the raster engrave process is complete DO NOT move your material inside the laser cabinet. Both Raster Engrave mode and Vector Cut mode in RetinaEngrave USB use the same “home” point for where the laser starts it’s engrave/vector process. As long as the material has not been moved between the raster engrave process and vector cut process the image will line up correctly on your material after finishing the vector cutting process.

10. Switch to Vector Cut mode by using the pull down menu and selecting “Vector Cut Only”.
11. Adjust the Black layer’s “Repeats” setting to 0 (zero). This will tell the laser to ignore all the Black vector objects.

12. Adjust the yellow and/or cyan layer(s) to your desired cut settings.
13. Left Click on the “Go” button to vector cut your material.
14. When the vector cut process is complete, the combined raster/vector job is finished and you may now remove your material from the laser cabinet.
## APPENDIX A: TROUBLESHOOTING

<table>
<thead>
<tr>
<th>Problem</th>
<th>Try</th>
</tr>
</thead>
<tbody>
<tr>
<td>The laser does not turn on.</td>
<td>1. Turn key to the on setting and make sure the big red E-stop button is depressed.</td>
</tr>
<tr>
<td></td>
<td>2. Check the fuse inside the 3 prong power plug (it is located in the receptacle and is a 220V 6Amp fuse).</td>
</tr>
<tr>
<td></td>
<td>3. Check the fuse on the power supply.</td>
</tr>
<tr>
<td>The current meter does not move when pressing the &quot;Test Laser&quot; button.</td>
<td>1. Ensure that you are pressing <strong>both</strong> the Test Laser button and the unmarked green button above the key switch.</td>
</tr>
<tr>
<td></td>
<td>2. Make sure the key switch is turned to the ON position.</td>
</tr>
<tr>
<td></td>
<td>3. Make sure the red emergency button is in the out position (rotate clockwise) to turn the unit on. This should also activate the side-fan and red positioning laser.</td>
</tr>
<tr>
<td></td>
<td>4. Make sure the red &quot;Laser Switch&quot; button is switched ON (this controls the actual CO2 laser, not the red positioning laser)</td>
</tr>
<tr>
<td></td>
<td>5.</td>
</tr>
<tr>
<td></td>
<td>6. Make sure the lid is closed and the magnet is contacting the magnet switch.</td>
</tr>
<tr>
<td></td>
<td>7. Make sure the unit is plugged in and nothing else is plugged into the same outlet if you have less than a 20amp breaker.</td>
</tr>
<tr>
<td></td>
<td>8. Try a different outlet in the house.</td>
</tr>
<tr>
<td>The current meter moves when pressing the &quot;Test Laser&quot; button but no laser beam is present.</td>
<td>1. Put a piece of paper near the stationary mirror and press the laser test button again with the lid closed.</td>
</tr>
<tr>
<td></td>
<td>2. If there is a hole in the piece of paper then your laser is working but the mirrors are out of alignment. Align your laser according to the provided instructions.</td>
</tr>
<tr>
<td>RetinaEngrave USB shows &quot;write errors&quot; or &quot;disconnected&quot; anomalies when communicating with the laser.</td>
<td>In some cases, especially when using non-brushless motors, EMI can disturb the communication between your system and the RetinaEngrave USB card.</td>
</tr>
</tbody>
</table>
To isolate this problem, disconnect the RetinaEngrave card from the Mach3 card and connect it only to your computer.

With the laser, Exhaust Fan, air compressor and water pump all powered off, press "Go" within the software. Because the software is able to communicate with the isolated RetinaEngrave card, this test will determine if another device is causing the disturbance.

The solutions are:
1. Ensure the power plug is pressed as firmly as possible into the power plug. We have noticed sparking occurs when the power plug is loosely put into the socket which causes EMI problems.
2. Replace the power plug with another power plug and inspect the contacts are tight.
3. Move the computer away from the motors and retest.
4. Do not plug in anything else besides the laser into the same electrical circuit. Turn off all external fans/pumps/etc.
5. Try a computer that runs Windows 7. We have not encountered any problems with modern systems and have tested Windows XP, Windows Vista and Windows 7. If the system comes preloaded with Windows 7, this is a good indicated of fitness for use with RetinaEngrave USB and the Hobby Laser. If your computer runs Windows XP, try it on a computer that has Windows 7. Windows XP is over 10 years old and Microsoft has stopped selling it. Old computers may have buggy USB chipsets.
6. Contact Full Spectrum laser LLC for their EMI shield add on if you continue to have EMI problems.

Vector Lines appear incorrect in RetinaEngrave USB
Import all your drawings into CorelDraw X5 (free 30 day trial at www.corel.com). Reduce all lines to hairlines. (see tutorial section below)
Different colors (such as red/blue) will appear on different layers when printed and allow for different

Vector Lines are cut twice

Use CorelDraw X5 and reduce all curves to hairlines. Non-hairline curves will cut the outline instead of the center of the curve.

Vector Lines are not printing or laser only rasters (no cutting).

You are not using a vector program. Try CorelDraw X5.

Bitmaps are absent from printing of combined vector + raster.

Make sure the DPI of your dithered image is greater than 250 dpi x 250 dpi. You can export to 1-bit BMP files if you require higher resolution and use File\Open in RetinaEngrave instead of direct printing.

While engraving at high speed or jogging, the laser head appears to stall but works fine at lower speeds.

Loosen the X belt tension of the laser through the access hole with a long 3mm hex key as described in the Hardware Setup section.
APPENDIX B: SPECIFICATIONS

Outside Dimensions (LxWxH): 31.5"x20"x12"

Boxed Dimensions (LxWxH): 38"x27"x17"

Net Weight: 70lbs

Gross Weight: 80lbs

Maximum material size: 13"x16"

Maximum engravable area: 9.5"x14.5"

Standard Lens: ZnSe 2" FL

Maximum material thickness: 2.75" (with Z table removed and 2" FL lens, 3.25" with optional 1.5" FL lens)

CO2 Laser Wavelength: 10.6um

Maximum Laser Power: 40W

Maximum Power Requirements: 660W (main laser unit only; excludes water pump/fan/computer/accessories)

**Important:** The current meter is used to tell how much power is going to the laser. Keep the current **under** 15mA for maximum laser tube life.

Avoid running the laser above 15mA for extended periods of time. Use more passes instead of more power for thick materials. Running above 20mA will drastically shorten the expected laser tube life.
Full Spectrum Laser LLC warrants to the original purchaser of 40w Hobby Laser that this product will be free from defects in material or workmanship when purchased, and under proper, normal use within 60 days from the original date of purchase unless an extended warranty option is purchased.

Full Spectrum Laser will replace or, at its option, repair the defective part(s). Normally, Full Spectrum Laser will supply a replacement part for the customer to replace. Once the replacement has been performed, the replaced part must be returned to Full Spectrum Laser.

In the case where repair is required, Full Spectrum Laser requires that the defective part, or machine, be returned to the Full Spectrum Laser facility.

Full Spectrum Laser will be responsible solely for the cost of parts only. All other costs for replacement or repair, including, but not limited to, packaging and shipping both to and from Full Spectrum Laser, shall be paid by the owner. A “Core” charge may be required by Full Spectrum Laser to insure the return of replacement and repair parts.

This warranty excludes any damage from abuse (including, without limitation, incorrect voltages, power surges, fires, improper or insufficient ventilation, cutting of corrosive gas producing materials such as PVC or ABS, “acts of God” or other situations out of the control of Full Spectrum Laser), failure to operate in accordance with instructions provided in the Owner’s Manuals for the Full Spectrum Laser 40w Hobby Laser, including specific safety and operational warnings contained therein, cosmetic damage sustained in use, and damage caused by unauthorized modifications of any equipment. All warranties to original purchasers are non-transferable. The registered owner must initiate warranty claims within the warranty period.

THE ABOVE AND FOREGOING IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED; INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT ARE MADE BY FULL SPECTRUM LASER ON THE 40W HOBBY LASER. ANY WARRANTIES IMPLIED BY LAW ARE HEREBY EXPRESSLY DISCLAIMED.

No oral or written information or advice given by Full Spectrum Laser, its dealers, its distributors, agents, officers, or employees shall create a warranty or in any way increase the scope of this warranty. Neither Full Spectrum Laser nor anyone else who has been involved in the creation, production, or delivery of the Full Spectrum Laser 40w Hobby Laser shall be liable for any direct, indirect, consequential, or incidental damages, including but not limited to damages for loss of business profits, business interruption, loss of business information, adverse health impacts, fire, and the like, arising out of the use or inability to use these products.

Full Spectrum Laser LLC provides no warranties whatsoever on any software used in connection with Full Spectrum Laser LLC products.